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S7-300 1 S7- 400 A TEIE (LAD) s
http://support.automation.siemens.com/CN/view/zh/18654395
S7-300 Fi1 S7-400 ffiEA)R (STL) 4aft
http://support.automation.siemens.com/CN/view/zh/18653496
i f] STEP 7 V5.3 % fe
http://support.automation.siemens.com/CN/view/zh/18652056

S7-GRAPH V5.3 for S7-300/400
http://support.automation.siemens.com/CN/view/zh/1137630
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EUBSHI, a2 TR . M8k ST-GRAPH /I, LA it s L FB (OTE I, 16 FB 7]
DAL ERE A, 140 0B1.
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INIT_SQ:=MO0.0 '\ <« | DB
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INf A e, DAORFE—2rE
Kl 3-1: ST &P H4 A
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B, 76 STEPT MrpAEpi—ANEiiH, HAS ST Soure SCAFYE, FiA—N8Y GRAPH Source,
ISP
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'23: book_graph -- D:\Siemens'Step 7' s7projtbook_gra

=-£28 book_graph Bl E] GRAPH zource(1) |E] GRAPH =0
= {E_?| 57 Program(1]

g oo Chrl+
Copy Chrl+C
Faste ZhrlH-Y
Delete Dl
Insert New Ohject STL Source
PLZ k SCL Source

SCL Compile Contral File
Rename F2 e
. . GRAPH source
Chiject Properties. ., alk+Return
Special Objeck Properties k Graph group
= ! = State graph

External Source. ..

Bl 3-2: A2 JlH ST-GRAPH F& /7
FERL: FP AT BAFE Block SCAFJEd@ A —AN GRAPH K5 aUf¥ FB, 53 NJESCIEIIX B, e e A ST
Ja B Ay RN VR
B AE ) GRAPH source Ji&, o LAFTIFHI S Siii, W FIA:

E'EST Graph - [FB2,DB2 (Step 51) -- tools_example', SIMATIC 4001 . CPU 412-2 - |EI|5|
T+ File Edit Insert PLC Debug ‘Miew Options  Window  Help _|5’|5|
D8] 8| = | | %|m|e| s ekl 4 1Y Re||[o% -] §]F=[afF
izl=l | Step comment -]
8| .
—'&=  Pemanent instn & |
k g H-E% Sequencer
t 2: Interlock
1= L -
lé: % 3 Supervizion 2
£ L — v

LELE

= 81§ |initial

(? iinitial i TR

151 N —— N R TR iz

i —R= Pemanentinetm ™4 | 1 gy o _Fl E wc
i i Trans1 |k [ GALES)
I = TR 4 = tiﬁu‘m . _|
Z|Decompile: tools example’,SIMATIC 400(1%4CPU 412-2 DP4...4FE2, DEZ2 - <0ffline>
HWarnings ocourred

4
arning »»r» (1A) without contents
arning »»» (I8, Condition) ConditTon iz always true.
0 erroris) found; 2 warningfis) found

[d[ 4 [ & [¥ ] Compile # Decompile Messages 4 wariables # Gddresses b Forward Cross RefersncdO |, Backwand Gross References £
Press F1 for help. 2 |offline FIE| Ins | o

K] 3-3:S7T-GRAPH F /" 51

1. TH%
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PRUEDIRE: TN SCAEThRE, GIAETIT, fRAF, ), RGAEDIRE
MEZIRE « AR, W& Bon iy 544 4F
Witizas: WEMPERICER, Worss, B, DA%,

LAD/FBD: 1] LAk &g 25 S INLAD/FBD¥E 4 .
3.2.3. THEKX

TARDXEST-GRAPHH 1) 5 L (R X 4sk, S TR FR) AR DR I 4

Step comment

D

lhmhm 55 1 B 4 (;%Eﬁ&
— ¢

Superwision ﬁﬁ‘]ﬂﬁ}’f%’ﬁ:
v tfa@wmi%
LIS 4 £>j """ S1 Y |[initial
|| initial | GRS
) . : ______ ;__"’Fi}_: R ”Hﬂ |'-—-|El.a.-'
eI |IB
| I | e —%1 T _
g ran\i R |7 LA
WA : HTD
i RIS 4

P3-4:S7T-GRAPH T {EX ALK
HB4F (Interlock):
Interlock sEEEDI—ANATgAREAT, CR AR B AT L o
o WP HAIHM: (Interlock) i, W HAAKAAIE RS HBEHAT (FEST-CRAPHHF &
I'1 5 Interlock IR KHIFES)
o  WHEHBILM: (Interlock) ANL, NI:
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o S HBILMAE TR BAY AT
o HHETRESHNL (A event L1)

RN AN (Interlock) 5% n LAZRGN32MLAD/FBDICE, & TAER P H7RE “C” kKR, W

REANTHSAT (Interlock) N7, EIEARME, RN LB LR L

Bl 5

Ak SEL g
ERCNIE]

B S R e T 90 v e A, B EANAE (Interlock) AR, UM T 4
TR .

He
=

|

3 Permanent i : -
| [
:. Sequencer ! jCme!

R <

temp

«gﬂ«. __JI
temp_limit
' Supervision

SR AL

II: T#OO0ms
T T: T#3min3s
valvelh
N C I 1B”
—"=  Pemanent | e
G
FEHET -1
« | o level | |
w[lE |, - | »i
:":Il Address | ... | Syrbol | Type | Zomment | Status value |
Q1.1 "f e BOOL 0 I T 90 i
DEz20.DED4 "EE imitE REAL 4.0
DEZ0.DED14 | “ZE temp_limit  REAL 0.0
DE1O.DED4  “{EIHE".temp  REAL 29,0
DE10.DEDO "{EAE" level REAL 3.5
[40 4TIl Cormpile  Decompile Messages A, Wariables b Addreszes & Fonward Cross Refersnces A, Backwand Cross

P35 : B A48

IS5 24 (Supervision):
Supervision ARSI ARSI, SR M I T S HR RIS

R A AT (Supervision) Wi, WIEEAE VI KA, WSS AFFEEE N 8, Hird
PRFFGS, 2 BEE e Si. U 51k,

R IR AT (Supervision) AL, JFH AR RN — D RS GATAL, IFEER e
Al N 78

RIS (Supervision) fZ A LAAAI2ANLAD/FBDICE, 7E TAEX TR “V7 ks,

WEREEMEFEZAT (Supervision) A%f, HICAGIRE, RGNV IR SAAMAL
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3.2.4. REQ

NI % 1) Graphi c FL K«

. . S~
— S Pemanent instructions before sequencer \

E-ET Sequencer 1 o
JIi 42 2% 2 Hi ) Permanent

53
instructions

— 5T Bimanent instructions after sEqUENCET \
JIji#% %% 2 J5 ) Permanent
instructions

| T:S Graphic 3§:§ Sequencer | =f:: Wanables |

Kl 3-6: MBS % [11¥) Graphic #K]
Permanent instructions: HESCJRENKAN, € MRS, wf LGl A 8 g7 B v g X
i, 37~ Insert New Element—>Permanent Instruction F, #£Ff Condition 5iE Call. it
IS 25 PR A QAT IX L8458 AT LAFERE AR IS B 0 AT« 7T LAAE ST-GRAPH [#) FB ¥ SRR 211
a4 CRUELBIHRIL T ).
VEE: Permanent instructions H iz, HI:
o LAD/FBD #Xff) AND, OR, LAGHR4 (hE4S NETWORK 5% i] LAZR4H 32 4D
e CALL 84
W A5 Permanent instructions {fH LAD/FBD H'EHAFR4, KX &% 5 N FB, FC, X

Jai Fl CALL 4% 5 A o
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E'EET Graph - [FB2,DBZ {permanent instructions) - book_or - | Ellil
It File Edit Insert PLC Debug Wiew Options ‘Window Help _|E’|5|
D@ & o |- | slmlela] wlh] s D w7 <
8l | e
ﬁ e Pemmanent
i # FPermanent instruecticns before sequencer
] /E 1 | M. 0 MO 1
A b R (=)
A E L2 Sequencer e \ial\ \
e _I-E: PE[ITIEII"IEI"It M /sz = JH:ALEAL/L fﬁﬁ El,(]
= F5 A IS BRI
E 2 [CALL “SCALE
& IN:= (INT)  (IN)
— HI_LIM:= (REAL) (IN)
A7 LO_LIM:= (REAL)  (IN)
Ior BIPOLAR: = (BOOL)  (IN)
= RET VAL:= (WORD)  (OUT)
— OUT:= (REAL) (OUT)
r—
T oy, BIFLFAT, By CALL
= B NI FERAAT, B
T FC, FB %%

K] 3-7: Permanent instructions {#H]
1k 5 7 1 (f1Sequencer LK :
Xt FEEANST-GRAPHIMIFBRESE, 1] LAudE £ A Sequencer (45 %8) 1 HL A5 S0 2 AN 424 2 Ak WA ¢
o 0] LU WA T Sequencer MA K]

T Graphic EE Sequencer T Wariables I
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K&l 3-8: ¥ & 11 Sequencer #LE]
WEYE % L1 Variables & :

ZEST-GRAPHIFBRE >+, A DL M W % 11 fVariables¥L&, £4& FHgmiitn N &R

H- N

F#-{m] Blocks

E§|-- Syrrbals

[+l Libraries

[#]-E*, Silraph Addresses

=|:: Grap}'icl EE Sequencer =f:: W ariables |_

K3-9: HE'% 1 D fjVariablestR &
3.25. HHHEO

MTUEEMEGR, RN, KXSH5E
INDOF S

BIRTEL, B, CPUARASAE.

S

3.2.6. ST-GRAPH ¥4\ [] FB 5 Source ({4

FEAE R STEPT TRH J&» Al LA i W b 75 X A2 B ST-GRAPH 27
o S7-GRAPH #% =) FB, A ST H P i) Block 304432, Insert New Object—>Function
Block—>Created in Language %4 GRAPH
o  S7-GRAPH #% =) Source XA, A8 54T H P Source X3¢, Insert New Object—>
1EH¢ GRAPH Source
PIE EAHBEH: ST-GRAPH A% XM FB AI LU 3¢ . File—>Generate Source File 2 ST-GRAPH #%
M1 Source JCAF; ST-GRAPH K3 [1) Source SCAF W] LUEIE S File—>Compile i) S7T-GRAPH
1% xU) FB.
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P BIX A ST-GRAPH #%:XfH FB {RAFIN 2 H AN AT TERA 3, W RATTERA R, WITCVE IR AT
ST-GRAPH #43(H) Source SR LABEIN GRAF, AR &AM k. FB ORAFG RV AT AT AL, "L
G ST-GRAPH 4% 3U Source UGB Td sk P R, oVl FAGRIR. R, ik
RABELRUE— TR 'S 58 G IE R IR, @I ] Source SCAFA% .

4. A% AL

ST-GRAPH #% 1) FB FE P 21X TAEM
o G ST-GRAPH HesH) FB, 80T LMEy M FB. L2 1
o B> ST-GRAPH #& X f) FB, #BHL70ic— 8 seldfn b, Sl DU RA7-AE FB ZH 0 E, 24
HIPIRA A4
o A ST-GRAPH A% (¥ FB, #ALFE = LEEH 5. i 8% 2 Wi Permanent instructions,

— AN AN gy, 3588 2 JG I Permanent instructions

4.1, WSS PAT R -
TR R I T SO 7, XSG 0 T4 2 ST ST-GRAPH A3 HL %L
Lo BRSPS HS LA 15 DU 4
o —MMHRMEH
o MM AT AL E KA
HERABHIEAZME (action) #dhdr, WANBLP T (active) , WIERZ DA
AT, WRAEZ AP HGE (active)
2. UGS P OLIR H -
o [EEMUEM T (active disturbaces), MUl H AV 4% I 2 4 1 (00 B B Aff A
o JFHRJFEDHFAAM (transition) L
3. AL FEIR AT K A S
4. RN 2 R 45 AT B SR A
o MBEARS CGump), FRINANESIERD, B FB KBNS . Wi
PSS &5 (A A 34
o IAEILRA . MR IR L

& (Step)
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5 ST-GRAPH Ry, TS5 50 AL o AR B D ol i ] — Loz 1, 1X L8z {E
AR RIS PRI AT (B, Sas BRI 2L D)
WG (Active Step)
Bad 202 A 24100 B 5 E IEE AT 2D
AR MERTE UL N, AR e -
o CHRIDTIH A AR AL
o MIULHIE SUAWIMS (initial step) , JF HNE B4 LA1L
o CUHUPH UL T HARISEH (event—dependent action)

4.2, Iz S5

51 S1 51 s7

-1 =-=T5 ==TH

212 ¥l @ @

& | & = I ©

13 ==T10
= =-=T3 T3 7 510
T4 S4 T11
G -
51 i . s1
\j
S1

Bla-1: s 454
H1 b B 7R B iy LU 2 = 0
1. ST-GRAPH f#] FB AJ LA i B 2 1t 45 by Mt 4
2. ST-GRAPH [¥] FB W] LI AL HREE PR R S IFAT S5 R itz 2

3. ST-GRAPH [f] FB 0] LLALIE L AN Ifidzs 5%
4.3. S uE
E TR RE W RIS aR, N 2
¥

Step + Transition (B+EEHSAE)

FEB R ST-GRAPH FB w1, BRINEA A0 Rk A, 1 n] AR EAERE L340 125 [
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B dett o DAL S 24U E B, ENSW ARG A — N5, M5 T Lk
EEBS.

Wi 24—~ ST-GRAPH FB #R I, Wz & o W1 ae 2 R OIS 4 PF AT, OB AN 2 it
g S b A th FB IS4 INIT SQ=1 #i¥ltntl, mRIuaL TFHRHAT .

15| jump cgtan s

el Open Alternative Branch (F]FFiE+£30)

i Close Alternative Branch (kP& )

o Open Simultaneous Branch (FTFFIFAT7r )

FJ . SO e 4 SN e
Close Simultaneous Branch (SCPIFATr3)

3 Branch Stop (433Zf551F)

g7 ‘

- Insert Sequencer (FHANIERE)

43157 Graph - [GRAPH source({2){FBD) {

F* File Edt Insert PLC Debug View

D> & o - | & | TEMERBET, SR
Cla | SRR R
T LS T ) e 2 il ﬁ —"  Pemmanent instrugjfﬁ/l
L ﬂ =-E% Sequencer'l/
T —Jﬁﬁﬁiﬁ,Lﬁﬁ¢%
2| | MR A G K
1= iﬁ | AL
S LA FI ) 7 3 EZZJ-_' S
E —'= Permam:
=
= Xiti PR AR ) 520 B4R 4
E Ja» AE AR AT AREAT 7
o A
=

Bl4-2: s TR
4.4. FEEHEREwE

4.4.1. BRI LR
B s R AR R SR 5, A8 AR X 0] DA AP 2B T e i, W R
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step comment
.
IR X
% A O Fm“ "
Interlock
l ¢ —
Supervisinn% im%ﬁ%ﬁ: A 5 e
l v ] A IKERIES
IR 4 &:::  sL YV [initial
E initial E R ”FFEHH’
. . e R "EITIE”
Finft A0
| | A R T1 F|["KEIC”
/AN ransl | |"HHEHED"
R "R ID7
[ e e 25 A
TS 4

Kl4-3: DR Rk
HREME: AP EbR, ERE Object Properties, HEEVILGD B IERIESE.

Properties - Skep il
M umber; IE
M ame; IStep3 [ Initial step
e RS Estension: IStepS
Comment;
Step cormment / ;I
s WG 1) J
AR

Cancel | Help |

Kl4-4: SH)EME

4.4.2. HHIBIHE (action)

NI
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I (action) f£ ST-GRAPH [) FB wh A7 BN, JH P K T 55 2 2D (s ok o
J, MREH P RAGER A IEIE (action) %

Ackion I

K 4-5: I nshik
AT DL I A s D AR A, NI sl .

BAERAT Y
EEIROH, ks
i
/Q‘\
H
(i
JIit
r%‘

K 4-6: $RLHATIY

4.4.3. FfE (action) 43K:
SAERT AR g LT LK
o HrHESNME
0 5 interlock 3K LK
o ETHAMNBNME
0 5 interlock 3K LK
o L HBEIEEEARBIE AR
o S, SENEE MAEARIE L WBE

4.4.4. BEIERS

Mgz s ol LA S S ERID, B AT 228D 5, b ios, I BRI 5 SER e 2 1A

Wik or o
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4.4.5. SMERITES

E (action) HIEAATEAHERTE ST-GRAPH T b A KBRS0, SifE A B3N 2445 2% ) LAD
MHREATEA—FE, A EREIRS . TR, A SCRF YR,

4.5. ST-GRAPH 54 Hhhl

TE ST-GRAPH FB " Af7F7E—Sehp g Huht, H 7 nl DG H 38 PLC Hbht—FER A X s hht, HAA
SR

ik P (L EWE
Si.T A1 AT R RO I 1] bLA, WA
Si.U A1 B T RO I I ) bRig, A
Si. X Bl 1 R I/ P fid R
Transi. TT | WoREHAMT 1 ZEWHL W/ A ik R

% 4-1 ST-GRAPH 445 Huhl
ST-GRAPH H545 ik (15 | A% =0 L T 1 -

T\g [——
53
__________________________________________________ =tepd
Step3d. X E T1
E [ Cmp H | i T
Stepd. T—| > Trans3.TT Transl

T#1 00M5— § i
Cmp N~
2

S N BAE 3 kA

T#100MS— 13 KPR

K] 4-7: ST-GRAPH A Hulik ¥ 5| A% 2
4.6. ST-GRAPH FB 23k &

H&: BT ST-GRAPH FB 2L EEFHHIAHNK, FUHBEOSHKNEE KaiFRENETFH
BEREBITEEERKEN, ZEINCGRA.

1E ST-GRAPH 4w/ #e 35 sbik B¢ Options—>Block Settings. .. AJLAIEAT FB ¥, W FE:
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Block settings

Campile / Save | Messagesl Process Diagnusticsl

— FB Parameters
% Miniriurn
" Standard
" Maximum [az of ¥4.0]
i~ User-defined [v5.x]

— Interface Description
£ Memaomy minimized [as of ¥5.1]

{+ Shucture arays

" Individual structures

v Download to PLC

— Executability
% Full code

" Standard FC required
WithAwithout meszages: FCF0AFCT
Il zer-defined: FC7F2

Minimized: FC73

FE mumber: I?E

— Sequencer Propertiez

[ Criteria analysis data in DE
[ Skip steps

[T Acknowledge emors

[T Sunchronization [as of 4.0

™| Fermanent processing af &l
interlacks immanual operation

[ e [ Lock operating mode zelection [v5.4]
i~ Maone -
& Al [~ Safe activation mode [az of W6.1]

[ Use as defaults for new blocks

Cancel Help

4-8: ST-GRAPH FB Z# &
4.6.1. ST-GRAPH FB S¥% & .

S7-GRAPH FB Z¥J(i5 H 14 4 Fh e aY.
L. Minimum , FB R AL$E SQ_INIT JABI24, QR HIRE P AU s AT 48 B s,
I AT ER e R b KR oh g, n DU PRI
2. Standard, FBOfEERIAZHEL WA AERRFBATES A, IR0 A
W EThRE. W LA R
3. Maximum (S7-GRAPH fiiA=> V4. x) FBAFEERINSEL, § IS4, AL 24,

WS
4. User—defined (S7T-GRAPH lRA=> V5. x) WHEERINSE, ¥ S, $L0LE Z i,
W

TER: JEFE FB AR A, W LT3l 0SB T e 2 Bk
NERIEX SRR, A AR TR A

EZIPRWILIFEARE S /@
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=N
mow | SUER | wrns o
(EFAEER ‘ (ST-GRAPH 4 #R)
H7K)
ACK EF MOP. ACK ”Acknowledge” (SR PSS THEIN
INIT SQ MOP. INIT “Initialize” WS UG A (W s 2 A7)
OFF SQ MOP. OFF “Disable” {5 g2, AN i A0 R Ak
SW_AUTO MOP. AUTO “Automatic (Auto)” | MEIFiE#e: HBHK
SW_MAN MOP. MAN “Manual mode (MAN)” | #i:ik$e: Fahil
SW_TAP MOP. TAP “Inching mode (TAP)” | Miztik#e: HDUY
SW_TOP MOP. TOP “Automatic or switch | #AiERE: ALY
to next (TOP)”
S SEL - “Step number” EFE, WOk / ZATREAE TS ON
/ S _OFF 7£ S NO P4
S_ON - “Activate” Fhiia: BEPEoR.
S OFF - "Deactivate” Fahi: TR o,
T PUSH MOP. T PUSH | “Continue” FOUD TR W R A AL
TV AT DAk A G SRR Y () AR
SQ FLAGS. ERROR - “Error display: Hrgivss:  “Ha”
Interlock”
SQ FLAGS. FAULT - “Error display: e R
Supervision
EN SSKIP MOP. SSKIP "Skip steps” WosE 2 1Bk o
EN ACKREQ MOP. ACKREQ | “Acknowledge fFBERIA TSRk
errors”
HALT SQ MOP. HALT “Stop segencer” {5 RSP U I HL o
HALT TM MOP. TMS HALT | “Stop timers” {5 E T D IS AT I T A bz
AT RO s S [R)
- MOP. IL PERM | “Always process “HAT H B
interlocks”
- MOP. T PERM | “Always “PATREARIL”
processtransitions”
ZERO_OP MOP. OPS ZERO | “Actions active” BALPTAAEREGE P N, D, L #4E3 0,
FEBOE SN BOE B R P AT
CALL #1F
EN IL MOP. SUP ”“Supervision AL/ FF e B
active”
EN SV MOP. LOCK “Interlocks active” | BAZ/FH{ERED AR

KT IEFE FB ZHUN PEANFE

#* 4-2 ST-GRAPH FB Z%{

2% ST-GRAPH T 5+

LB % V€ /RS AT (AR I e
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4.6.2. OB WE:

TEGRIEIETISE T, Interface Description & Executability PiANEIE B Y] B, ik
FWAERDN Memory minimized) B, @AZ0i%#¢ FCT3.,
1. Memory minimized i HJAAFE/S, (H2 W1 KRR D Re 52 i) .
2. Structure arrays LIFHfR LS 1 7 SARRBAE TS s BBl e, AN Rvrfr S 407K
il
3. Individual structures A5 [WHEIR AR R4 4504 7 A7 A1 Se s terh, Aair
P55 477 N5 )20 S e a6 o IR X n 1 s E i

4.6.3. Executability J&TH

1. Full code &fXfH4, FiA7izAy ST-GRAPH FB F2 7t 2 AR HOF 4l (L5 E FB H 5 4
H, AN BEAAMNI FC.

2. Standard FC required (O=V4.x) #rAEM FC, fnketbaii, W S7T-GRAPH {3 HIAx
£ FC (FC70, FCT71, FC72, or FC73) SRICFFFTATH) ST-GRAPH FBs. A FC b5
BT

ANE] Executability #EI N DX 51

Full code | Standard FC70 Standard FC71 | Standard |  Standard FC73
FCT2

WAE | B TE | 29 8200 745 | £ 7750 P ) 10700 | £ 8150 15

U S I NN FAT

1% p 7 ST-GRAPH V5. 1 | £ S7T-GRAPH V5. 1 T Tzl e, TP

B o] S S A AT | R B s A oA B W U, BBk
DAEHISEARIS ST, | SRS S, RA TR eI, TG
SENT R, THEAR L) | A%, THEERDIRE, RBE IR A R e E
fie SVRRERE 2} NP EEE I8

R 4-3 ST-GRAPH F2J7 5 FH W A7 175
4.6.4. IMEHRBEHERE

1. Criteria analysis data in DB 4f# 4] SIMATIC #n#EN HIFER ProTool/ProAgent i,

AP T A 2 M Bl 47 it £ 7 SR e
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Automation & Drives:

ﬁ:sﬂence in
Si'emens)

2. Skip steps WuEH BBk Thae CHRIT D
3. Acknowledge errors UTHAEIRFEZRPATI, KA T T3 (disturbance), I 2AZIAE

WMANZHACK_EF” AN, IEEs A Sk HdT . LIEIEH FB 4% &0 Minimum

INFANHTIE

4. Synchronization (as of V4.0) [A0 (4.0 LLEJRAH R RVPEBREF SRR D

5. Permanent processing of all interlocks in manual operation fET-ahfEzCTF, W

FEPEILI, T SERIE BT, B interlocks #HORAM AL, AR RPIRE T i
R

6. Lock operating mode selection (V5.x) BUEEA/ER. RGBS H, WLEF

SEATI, TR iR A R SHE TR (T a)/ AR

7. Safe activation mode (as of V5.1) ‘4 iEizt. kI L rsEIRG, X4

S WEGE I, RGEFINCRE T AT A REBGREE 1020 KBRS . Blin: 57 SCERFERE
P IS BRI, 53— D0 SCIIITAT DA e 205

4.7. ST-GRAPH FB F2FH S ¥Rk
ST-GRAPH FB /7 115 Se A SR Ar A i s AT I T A 15 S, PRk, S7T-GRAPH FB F2)/7 75 5ok
PEHAE R SIs TP A E EEMAER . GFE N DL S iR BL R LA

E ALY IR NS A A S B E TS

PLC WrH ), 5 S bors Ores, s BUN LIRS, ShAT W S an e i
e R, REREMCS ST-GRAPH FB FE/F 15 S HL py 2%, 5 LK 5 BRI %
PATIRAL, IFRS R Ge e A By

FEHER R, 205 ST-GRAPH FB FRJr i St R A A, Wl AR s 2R, dnfs
H55 A EH] .

TR {E N80 ST-GRAPH FB FEF@IN, stk b I v i A il
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x

Block: FB2

v Download with instance DE

Downloading the instance DE sets the sequencer to its initial
ztate and zhould only be carmed out when the zequencer iz not
TLInRIAD.

W Tuin off the sequencer before download

Instance DB: DEZ2 Browse...

¥ Download with standard FIC

Standard FC iz neceszam to process the zequencer.

Standard FLC: IFE?E
Cancel | Help

K| 4-9: S7-GRAPH FB ik &3k &

4.8. FREIEPBH N

T SRR DU B

FEH eSS R A ST-GRAPH FB F2FPHY, ST-GRAPH FB $4H45 Fll /- 42 1 e s A BRIy, T
FUNRAEAEH] ST-GRAPH (ISE 2. BRI (B mib MPRES, H Rt E R4, miF
LX) FB B SEE I G BT T XA AT LUA B RG] ST-GRAPH F£/5, ST-GRAPH f
J¥ 5 HE R G AT 1 FL

BT PR S U] 70T FB IBCE Ay Bl i), il B sl — & FB W S8l R 4ty ,
N

X 35 B KJE

T SR E
2 777 minimum

FB 244 ST-GRAPH FB #i N\ /% th 24k
10 775: standrad/maximum
AHfiE: user—define

R TAEX | GTT 0 16 715

L s A& AR (Bl Transl, Trans2) BRI Bk 16 7

R TAEX | G7S.0 32
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W S FR (il Stepl, Step2) A Ex32 P

ek | - -

W TAEX | - -

2% 4-4 ST-GRAPH FB 1 5t¥dth gty

XHF FB M SER U R TR S, 52 % R

. W AW 4| 4
N -6/ I I I

RS P g | TS| | HE |

A A

TV AR BOOL | yes | no | yes | no

T L2 QLR BOOL | yes | no | yes | no

TS K0 1)) BOOL | yes | no | yes | no

CF IV | CRIT FLT & HA R BOOL | yes | no | yes | no

TNO BoRH e XA EE: INT | nol no|yes| no
AL BRI, 4 LAD/FBD Tt E (B

CRIT % 32 HPIRES DWORD | yes | no | yes | no
AN BEE AT, B3 LAD/FBD JC %

CRIT OLD | (&% 324y [HPRE DWORD | yes | no | yes | no

CRIT_FLT | iS4 Ak4, HEG CRIT RE& DWORD | yes | no | yes | no

¢ 4-5 ST-GRAPH FB 15 5t ¥l e rp #4611 45 4
YT FB S StEdR e T A FN i, ES % Tk

BER | NEE | NER | AN | AMER

A1t Wi it} L 5 5 5

S1 ST NG BOOL yes no yes no
L1 interlock &B5FF34t BOOL yes no yes no
V1 Supervision HEAFA: BOOL yes no yes no
R1 LR BOOL no no no no
Al FE RPN BOOL yes no yes no
S0 SO 2 T FA: BOOL yes no yes no
L0 Interlock #ENZFHAF BOOL yes no yes no
VO Supervision BH-FHA}: BOOL yes no yes no
X BT RES BOOL yes no yes no
LA Interlock ANy BOOL yes no yes no
VA Supervision i 2 BOOL yes no yes no
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RA LR BOOL no no no no
AA LR BOOL no no no no
SS RGN TR BOOL no no no no
LS interlock JRZ&S BOOL yes no yes no
VS supervision JRZ& BOOL yes no yes no
SNO Ak e RS INT no no yes no
T A BT A I ) TIME yes no yes no
A TP G0 A8 O 1
U 1] TIME yes no yes no

A PRI, Interlock
H LAD/FBD Jo#% (% 32 1>)

CRIT LOC RS DWORD yes no yes no
CRIT LOC_ 24 interlock BJFI, K5
ERR # CRIT LOC JRZ& DWORD yes no yes no

MoEr A BB O oA,
Supervision #' LAD/FBD JL &

CRIT SUP (% 321 KPR DWORD yes no yes no
SM RGN TR E BOOL no no no no
LP RGN TR E BOOL no no no no
LN RGN AL E BOOL no no no no
VP RGN AL E BOOL no no no no
VN RGN AL E BOOL no no no no
H_TL_ERR RGN AL BYTE no no no no
H_SV_FLT RGN AL BYTE no no no no
RESERVED 1R DWORD no no no no

# 4-6 ST-GRAPH FB 1§ 5t¥dlsth il 451y
RN fRE:
WBEE: 11 ST-GRAPH FRFFATE, X IHAZ B R A
WIEE: £ ST-GRAPH FRFF AR, Xf AR B S B At
HMERER: {E ST-GRAPH FRFFAME, HeREFe honh AR B iR B
AN . A ST-GRAPH REFPAMIR, HG R vhodd A B ) 5 #R A
B WEE NS B RINIAS A ARSI GEEAIRESD, bR A A &P Bem N, ol
XFF Stepl. S1, MARHRAE Stepl BEANBIIRAS IS, Bl — AN .
AW BTG B RINIAE D AR IR A CETPIRED, LSRR R S B T A,
. %F Stepl. SO, MEARRAE Stepl HEAARMATIRA S, Bl — M A
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5. HFIER

R NG, ATRAIMT IR TAE. 76225 Debug-Monitor H, nJDLMSHLIMEFE 7 MBI IRZ,
{EZ 5. Debug—Control Sequencer "', W LLEHIN AT T80/ B a0, Murdes R,

ﬁ_ﬁequencer Control: FE2,DB2 ﬂ

~ Mode el | EGEE S
Scknowledge | Initislize | Dizable | Ve

¥ Automatic (AUTO] Step number: I

LD/ I~ Manual (M&N) fctivate i FAHRF,

Az Deactivate | AL BL R R
I~ Inching [T&P) Contiue. |
[ | Autarmatic on switch bo nest (TOR]

i, Errar dizplay

BEHEEF Interlock: || Supervision: ||

S £
frI R il 1

Parameters

[T Skip steps
2 T & ™| fcknowledge ermors
1, &% [" Stop sequencer
HWE R ™ Stop timers

[T Abways process inkerdocks
[T Always process ransitions

¥ Actions active
¥ Supervizion active
¥ Interlocks active

Cloze | Help

Bl 5-1: il D e

2 H. Debug-Synchronization AJ AP RS, BN FaB, of DLUER Sardas i, wr
K.
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Synchronization x|

The stepz shown in vellow are synchronization point: propozed by the system.
Select a step [or several steps in simultaneous branches). The steps do not

need to be yellow. v
. . . z ’
With "“Activate!, wou change from the curmently active steps to the selected ? VN
ztepz. With "'Update”, you can refresh the propozed steps. nf DL 8
| E M)A

|pdate | Activate I Cancel | Help |

________ T T: T#000ms

EC 56 valvel
| | valveC N C|Ql. 2 [

Kl 5-2: T3 pE
HERS: R UER S HREAN T3/ B3, ARBERS R (FEXTERF
BRAEZMTLR, HTUEEEELHBENIE, FINEENE —PREERF—F). Xt
RBEETRBERSEEE RY, RN ASREFERGEREW, FUENTER
ST-GRAPH ARG OHL T, HMEHBLIIRE.

2, AT RS T ST-GRAPH il & v 75 S0 Al A, e sty

A28 — S8 ] A SRR 2 28 S I8 R0 o) /5, A SR P i B .
6. S7T-GRAPH M T B T2

6.1. BUMTETZEXK

I THIKE LAFR REA0A RS o 0 JsURHC LU A 15 2k 25491 i W] ST-GRAPH FRAEEH] .
JsURHEE LE s R
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Wik ¢

Wk B >
W A > )7 D
g >

ﬁ%»

6-1: R R E

JSURHAC LEIA 1S 75 20K =P sk A, B, C #I—E I T ZERAATIR S, I HBEH 5 fa i)
D IAE N — LW I HAMERABAE R RN Z], W RE DB Tl X, e
AT SN 775 X

o [®IJA Q1.0
o [®[IB QL. 1
° I{H [JC Q1. 2
o PEFEHENL QL3
e [&®[ID Q1.4
o JEFEEAL  T1.0
o JEFEIFE  T1.1
B T 2R
WIHL

FITFITT A, Mk A ZIERREAL A I, SRHIIEIT] A,
fIIFIIT] B, 4yifk B BIARAL B I, SCHIIIT] B,
JEBE AL, 5 2Bl S R S R,
WA T Zi%E8HR “0”
o FTIFIEIID, WFELH.
AR 2R “17:
= DFTIFIITC, ik C BIARRAL C W, SCHII C,
= BB, 10 S SRR R, .
= FTIFIITD, FAELH.
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N JsURHAC EE T 2R I -

TITIE1T A

>

) 4

BIEBRAL A

KA A

v

TIT11] B

KA B

v
J BB AL

5 434

A 4

y
KPR FE AL FIIFIR] C

<
y

B T 2k $E=0 FIERRAL C

= KM C
FTFF1® ] D ‘ v
IR L
5 44
o 10 434
| D e PR L
Tk

K 6-2: JFURHEELE T 2L
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6.2. ST-GRAPH f& B/ f3l

JEURHAE LEIA T (P BT 55 i T AR S RO B iRe s A8 NI Bl rh, CREEH] FB2 40’5
JERHIC EERE o

1) mThresk

QSIMATIE Manager - [tools_example —- D2\ Siemens’,Step ;|g|5|
£ File Edit Insert PLC View Options Window Help =18 x|
DS | 29c | 4 Ba i g ||o 25 % o 5 22 | & |[ <MoFiten>
El--% toolz_example Object name | Symbolic name | Cres
EI-- SIMATIC 40001) 5] System data
=-[@ CPU 412:2DP o OB LAC
E-Ea 57 Program(ll g opas CYC_INTS 5TL
@ Sources o b 5CL
@i, Clri+ GRe
Copy CEFHC 3 STL
Paste (o STL
DB
Delet Del
elete & i

Insert Mew Object COrganization Block,

PLC Function Block,
R Funickion
SIS Cata Block
Compare Blocks., .,
Data Type
Reference Data r )
. Yariable Table
Check Block Consistency. ..
Prink L4
Rename Fz
Ohbiject Properkies. ., Alk+R.eturn _PI
Inserts Function Block at i SPecial Object Properties s 4

6-3: NINThREBR
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2) WEFEThRETRIY
Properties - Function Block x|

General - Part 1 | Feneral - Part 2| Callz I .ﬁ.ttributesl

Marrie: FB2 I . Irist. Cap
Symbolic Hame: I

Symbol Comment; I

Created in Language: [ GRAFH - ]

K 6-4: EHEINRESSERY

3) GufELE

EEST Graph - [FB3,DB3 (Sequencer 1) -- tools_example’SIMATIC 400 - | Ellﬂ
TF File Edt Insert PLC DCebug Wiew Options ‘Window Help - | Elﬂ

O|E@]| & © | | #E=|e] ] eldn| 6| <>t 82| [20% =] [F
8 =

—RE  Pemanent instructions before e
_ET

o | . Sequencer ] Block comment

s.| [-—;]

= | A —"%2  Pemmanent instructions after zequ

Gl = o

Eﬁ'#ir E

Jif PEH KA
= VIt o B

| =)

, , Transl
i ST
b

1k

1 < | H

1T e Grap... EE Sequ... I = Vari.. I ( | ﬂ
r |Ha.le ﬂ

iy [Irterface

|_I;

locks bl
ﬁ-l A [ml[t, Cormpile ¢ Decorpile Messages  # Variables 4 Addresses f Forward Cross References Jy Backuard ¢

Press F1 for help. &2 |offline FIE Ins IntmE
K 6-5: fifEcR
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4)  GiRES SR

E‘EST Graph - [FB2,DBZ {Sequencer 1) -- tools_example’,SI

IF File Edit Insert

PLC Debug View Options

Window  Help

=10l x|
=181 %

D)@ S| = | | &[B|e[s] eldl 6] 1[5t K2

B

]

1
=

%

¥

FPermanent inzt
E-2% Sequencer ]

HE RS E A

E7

ﬁ

Juis

A

=2 10 KT |
i

—HRE Pemanent inst

1

K

il

JUEH IR

VNI SR

A, A

alISEY

TE

il WL e
valvat fEFAEAZ

IT

Fr ansT

5T
fixARC
8
ransd

K 6-6: g SR

=]
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5) WIuHtAbE

|E|_| o it 3 =1 =N Y E‘h‘:|ﬁ|£| !K|>>!|E|||ﬂu% ,| iﬁ:

Interlock

— ¢ —

L Supervizion

—{ v

A5 $#->Insert New Element->Action
KA 1]

St e 4 Ll N S]- N 1nltlEL]_
%1@“%?#%%%75 | lI'.ll't lEl.]. R = Hrjjﬂ.”
T == R "1 ]B
!:' """ ) e —_ R_|"#[]C”
""""""" S;Fransl R "fwr EHLEs0"
R_["HE[ID”

K 6-7: Wk
6) HBIEM MRS

D= & = o o] e s eld 6 !<%i|§‘>!|£|“?u% =

Interlaock ﬂ
il ! [Cmp| {C
k= FEHE" —~ —
= |'T temp WE BB fifk

s sy LR T R
e [5! temp_limi t
1 A7 BB 4 R 2 H Y
7 1 UL IR M =
E’ Supervision e o
= l — v — R AR, FTIFITT A
= S
= EC 52 valveh
il valved N Cl g IA”
I |_________.I_._2____I
it | o] o -
= Transd
RIE". —| >

i evel S 3 JFIEIALE - |
% e WL T
| — limith =
=l 4| | Ll_l

6-8: LI
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SIEMENS

7)) WAL
D|dl & o <[ | #|e=|e]e| bl 6] <20 K2|[[70% -] &[5
il Interl ock il
] l - c
i Supervision
i — v —] HUHLBERE 5 408
st B
3 84 T\ [rixaB
i i le_AEI E L -"ﬁj;*{ EE;*”_.E fj]”
pl P! T#GM
=i
i ! mo] (EREECEEEEEtE T4
ﬁ g | Transd
=| caleet ¥ L WTEBHERR
= . 0, WHATYwS 4 Wike
[
a7
TG

[Cmp| BREEEEEEEE LR >

? BE —| /;Frange'
£l ow

'M' selecI ﬁj\fi 2: ﬁﬂiiﬁﬁlﬁﬁﬁ
1 — H0, WIHATH S 6 HikE
' B 6-9: WiRH Y
8) AmEILIR 6-7 HAAFE Y
9) S5 4R

DB @ = -l | 2|zl ] el a] 1<) K2

oo o &

IE'I]E“’E ot |40

-
1

HlaE sl =

B

N

i
=T

=52

Interlock

l—ic}—|

L Superwvision

— v —

T4, T2

S5 v
valvel

TS

Transh

valwvel

I'lI |.‘1Fﬂ |'|j]:l.".‘

AT 2SR

K 6-10: Wifighp
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SIEMENS

10) 5. Options—Application Setting TS E, AWFIIEFET FB He/MLSE L 200,
FARE SUE S 25 32 5 R (1) 3 Bl i BH

Application Settings

Generall Editer ~Compile / Save | Messagesl Print I

—FB Parameters — Interface D escription

% Minimum A ik FE " Memary minimized [a: of ¥5.1]

™ Standard wRNBH % Shucture anays

" Mawimum [az of 4.0 " Individual structures

" Eutended [as of ¥5.0) W Dowrnload to PLC

03

— Executability Z'K/Zjﬂfgﬁ ¥ — Sequencer Properties

* Full code = [ Criteria analysiz data in DE

r. Starjdaru:l FC required [~ Skip steps

WithAwithout meszages: FCF0/FCT

Uszer-defined: FC72 [T Acknowledge emors

Mirimized: FC73 o

FC rumber: I?E— [ Svnchronization [as of "-Tr"4.I:I]
I™ | Permanent processing af al
_ interlocks inmanual operation

R [ Lock operating mode zelection [v5.x]

" Mone

& Al [ Safe activation mode [az of Y6.1]

K 6-11: 5k E

11) AEERRIT & H 3P, (E 0BL il FB2

0Bl : “Main Program Sweep (Cwcle)”

LISLTRI : Title:

CALL FE 2, DBZ2
INIT S0 :=M20.0 WA S

gyl

K 6-12: i H FB2
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(E;:.eﬂence in
Automation & Drives:
e SIEMENS

12) N5, W FB2

L e e S T e e N e A

==l ‘
—HRE Pemanent |
EI-. Seguencer ' Inferl'_:":k .
g . CoF--e
\ + Supervision —
N\ :, oy '}____! BRI
i 1 Ff 1] U: T#2min30s018r
i e g . ) : T#Z2min30s01 8
= | |initial
R[4
R [ JE”
R_["#gi1C”
R " Bl
—"= Pemanent i TR

K 6-13: Wi FB2

13) A “HEEITIE” O “17 )5, W ASTIE, ST RGEHER, AT

=l | Interlock
_ hex i
= Pemanent i | Cmp { C } I
El Sequencer g | <
temp
"
temp_limit

. Superwisieon
1

v

U: T#2mind0s
 T: T#%mind0s

valvel

NC | 1A

= Pemanent i L
Cmp === - - i

R - ]
lawel 5

TEE -
4 | i3 limith

K 6-14: iR FB2
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Excellence in
Automation & Drives:
Siemens

x|

HH

= Pemanent |

E|:. Sequencer

SIEMENS
14) VRSP ST, 4F Addresses HR] DLW 5 2R e A A ) AR
i Interloclk i il

) ST Py
L EHE |
! temp E E
S |
i temp_limit | ! !
e

S U: T#OOOms

Tz T: T#3minds

valwvel
N C B

—"=  Pemanent i

‘—;E;ﬁ{r

FEHE -1 >
e level | |
B[R - -
ikt J | »
x| Address | ... | Syrbal | Type | Cammenkt | Skakus value |
H
1.1 " e[ ]e" =l ]
DEz0.DEDG "B limitE REAL 4.0
DEz0.DED14 | “Z#1" temp_limit  REAL Q0.0 ik T 90 JE
DEIO.DED4  "fHillE"temp  REAL 92,0
DB10.DBEDO "{EAL B level REAL 3.5
[Al 4T mTwl]% Compile f Cecompile Messages  #, Wariables # Addresses £ Fonwand Cross References #, Backward Cross

6-15: i J5 A = A
15) 2% Debug-Control Sequencer ] LAFEHINFHAT T80/ BB, Murisas b &,

_Sequencer Control: FB2,DE2 El
— Mode
Acknowledge | [nitialize | Dizable |

[ Automatic [AUTO)

Step number; I 5

¥ Manual (MAN] fctivate |
Deactivate |

I Inching (TAF) Coniiue |

[T &utomatic on switeh to nest (TOF]

Error dizplay

Irterlock: || Supervizion.

Cloze

| Help

6-16: 4= HThRE
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Excellence in
Automation & Drives:
Siemens

SIEMENS

FERR: BT UESAARFNT/ AR, GRTMER PR (FHREATE
FFRREFMTR, HATUEEEELHBENSE, INMEENE—PREERF—2). X
BRI BREAT BT REEA RS, TR NG RAEERMGEREM, FUENTEZR
ST-GRAPH NGO T, HE A MLIhRE.

Ak, — A ST-GRAPH 7 /n Gt 45 R 1, A SO AU AR T e T A 4. AR
G FEih S A A, IR A TSR, KT ST-GRAPH R HARAIE I, 4% A SR AL
(b RE R4 ST-GRAPH T
R
S ARSI LR B RS TR, ] AR R ) AR e Rk
ATHRRE, WEEE VIR L TR SR .
S T ULH TR G AR, AR ) DA S g S A BRI A . R R X LR
JE AR D)y ReVEBGRA T 5TAE, (A XU B f.
VTSR 01 (R R S S AR SR

7. S7T-GRAPH % . ] 55

7.1. 5 IEEAHSC R &
7.1.1. A BB

R AT AR 100 D, W PSRRI BT ms o 2 R S P AL e o o 2
it XA T ST CPU RAERIARL, Apewi 2 REIIREIE . X S7-300 CPU (CPU318 fR
A8, M EGE I 100 B, KB kA BRI, i CPU318 FIl S7T-400 AR AH N ¥ I FRAAKS

I 200 5.
LIR7VSRP

e {F ST-GRAPH #m#iH2%f, /F “Optionss > Application Settings... > T1%%: General”
2F, MBI “maximum number of status jobs used” BEIHAMEMLAESSH. IAESTHL
FEO, AR T BE 2 CPU (I R UK.

o {EHIThAESESRAM CPU (1 CPU3L8 Y CPU400) .
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Excellence in
Automation & Drives:
Siemens

SIEMENS

o IRDBEAFHLEL

7.1.2. A SRV

s N ALE HEBEE, BIAE R 25 P O AL I 2 2 B v AT DI e

iR R ST-GRAPH R Fy IO H9 SR Bl R A il SN B80T, T RER 2

Do, LRARCH WIS DLk

P A AL, (B B4 AE Step 1
B A AT RS A B

S SBIRF  A Akt

it 77k AE SIMATIC FEESSAI CPU HHIBR TS S Edin bl . SRJGAE ST-GRAPH %’ 2% b R A

PR DB IRB LA CPU,

H 5988 4E ST-GRAPH SEBH “Optionss > Application Settings... > General> On Saving”
HIGETH, N 243%E# Include instance DB, X#EX4H FE X FB &I FHLH, FBHIE R
WERWAEEH . FVGERT, FI TR E SR — B, B2 RN HIN R ERSE 7

BEREFAE R, AEAEKIRTIZ.

Application Settings

General | Editor I I:Dmpilex'Savel Messagesl Frirt I

— Mew Window View
{* Sequencer Dizplay with:
" Single step ¥ Comments
i~ Pemanent inztuctions ¥ Symbols

[T Conditions and actions

T Uk B — Conditionz in new blocks
I, FTERFr {+ LAD " FBD
IH g — On Saving

ok ¥ Include instance DE

—

v Generate reference data
¥ Generate FDIAG data
[™ Use extended names for display systems

7.1.3. \E: TEIEPLREE S

T= 1 BlE B R 751

. b ST-GRAPH FB 2 )&, MATANREEALE .
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Excellence in
Automation & Drives:
Siemens

SIEMENS

2. 1ERTY “Interface Descriptio” %I, HHELTEFT “Download to PLC”. UIHEKH,
LESEHL “Options > Block Settings > Compile/Save” T E “Download to PLC” #Ii. %R)5
FOH R WEIZIETUS, T4 ST-GRAPH FB I, 2 L4k 4 N3] PLC. 1XHFE, FH T LA
TR T

7.1.4. M REEISVIIEAL

. A RMELERR N “OFF _SQ” Jy TRUE B B ESA7ER AN “INIT SQ” I FF-Hy o 2
fift%s: HIN “OFF_SQ” K& “INIT_SQ” f&5#0it LIy am, Wit ef e mass enmi
6 (TRUE BY FALSE) ¥ KFR. K T By ks sfEw a2 Ja B 8hEs: TAE, TEIC AN 3 2 i
AT LLE R “SWMANT (i BT VI 8 Fah . AR 2 n, RS IR FFEIIR LD
B E B RO HE) A s, BltnE 24 “SW_TOP”,

SR XSRS B E) ETHEA R

“OFF_SQ” % A%

“INIT_SQ” HIAAHLIz i

“SWMAN” BRSSPI B A

“SW_Top” LAk FE: HZEUIRB] N A

7.1.5. . ST-GRAPH B HL /PN

W 8. ST-GRAPH FEF¥ %k CPU 172

fifp . ST-GRAPH Ry AU AR/ S iR as N BEE AR, EG AR I BEE S R e,

FIP AT L SOWHERE I D RE e 5 M I N AE Ko A AR HED REDR FCT0, FCT1, FCT2 8l
FC73 I, ST-GRAPH [H&Er RGLNREMI S FARIXLE L REH, IRy sURL &4 ST-GRAPH F2
Fedi/b 5000 7745 o AEFT T RIX L bR AE D REHIR T [RIRE 7 N2 25 0] 2R — AN IH o 24
ST-GRAPH FB )y, Jf HIX£E ST-GRAPH F£ /34l & SCRAE I ARHELh EB 5o A, eI AR
GOy Re R AR AL AR HE D BER S, XL bR T e K A2 — OO M EIRT, IXFERTY
BT AN

A LUE R 41 2 A0 ST-GRAPH FB Bl ST-GRAPH DB B 5 N AEIR KN,

o FB MINAEFER: 150 F47 + n * 16 FA
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Excellence in
Automation & Drives:
Siemens

SIEMENS

o DB MINAEFENR: 236 F47 + n * 26 FA

n: IR

LRI 7 25 T Wl 2 PEASERAT 20 AS2B ANE A AR IR AR o A P Bl AN RIS BT P9 A7 1)
(7R A2 S /s37 7

YRk E N : “Full Code” #
ST-GRAPH FB DI BRI b (MCT  ARBE) WAET SRIFSE T

o

o FB HAJAAETR: 4900 FH7 CEHIILED) + 130 TR0 + HA et 7540 GRS 29

o DB IRIGNAFTKR: 270 75 CGERIILTD +70 FHRED + Bt 8 (RIS A
TSR

e FBEMINAETRZA H: 4,900 + 20 x 130 = 7,500 FF

o DBHLINAETRA K 270 + 20 x 70 = 1,670 FF

GRS TCE N “FRYETHREER 7 ( ST-GRAPH V4. 0 ZRLA_ERRA)
XIS MR P BT 75 AP R

470 A5

o FB BRMNAEHKRLAN: 160 T4 + 20 x 16 775

o DB IRIJAAFTRLN: 236 F95 + 20 x 26 7 = 756 719

LS TR S AMED R B FCT0, FCT1, FCT2 FI FC73. #ltn, FC71 #% FB7 &FH FI FC73

e ST-GRAPH FB 1], IXI CPU 47 HUSNII 1 177 %

e 8150 FT (XfF FCT3)

e 7750 “F5 T FCT1)

7.1.6. W@ Wil iR —R 5D H A

W) s el o W] 20 43 SR A Bk A — R AP 1 s ) 2
. E NHEME -, nf LB FEIZE P S5 kWb S2 & S3 IRl b S2 % S3 I
IERE R AR 720 Sh s I a], 20 S5 #E AWM.
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Excellence in
Automation & Drives:
Siemens

SIEMENS

FEFFG Oy Sk, Bk PEAlRED

S2 Ju 85, 2 82 K S3 ARIFAVSFREEL S5 RN, IF

TEREAR AT T3 AEE5A. 4 TP EIEARD S5 R gufe i i (8], DD EA0n, Fefl gt 13

S5 25t N s 2T S

M1.1
M1z c

M1.z c L.
mMi.4 0T L

NTHwFEE S2 M S3 WA AL E I, 5 S5
HOUDHLER “U” gt isysintial, 2 So [RMaEE Al 4s. SIANSE “ACK_EF”

HiR, HgdREbRE 0.2 .

¢ T T#Z3250ms
L_T: T#25250ns

Ztepl

N [me.l o]

TU: T#dsO006ms

__T: T#15s062us

Steph
u o [mo.z
T: T#lsledms
_ T: Tglslédus
3teps
N [mz.z 0]
jouoss s U: T#l3s898ms
Transi
__T: T#13s8598us
3teps
T
T3 TU: T#ls777ns
---------- -—
Frans: T: T#ls777ns
54 Stepd
S N [mz.a o]
T4
T -;a:nsll

Kl 7-2: [A20 5 SCH T IR A It 1]

(RS0 € T Mifesktt. B 725 S5

B ERRVN
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Excellence in
Automation & Drives:
Siemens

SIEMENS

MW PRI R A S I ) B g AR T, AT LA BRA P I R R IE Y. A BT 4. S50 “SiT” K
“SiU” BRIE W PAFE ST-GRAPH V5.2 DA _ERAB TR E . Wi 8] i BROAE T DL o ke e . «

Options > Application Settings... > Editor Tab” #iA

— Default values for time moniboring:

Tatal step activation times [T 100 i

Step achivation time without disturbance [L): 100 ms

-3 B N )
7.1.7. M. Jovk WIS WS B IR

)R Ry AT TGk A5 D O I 1) ( “STEPi. U” ) 2

R W SRICVE M D G I R] ( “STEPL. U” ), IBAJRATHESE “Compile / Save” F4rffidik
LR T FCT3 AN FCT2. HUAR FCT3 ] B i/ ST-GRAPH FB [N ARG =K, fHZIXF =
PEREOR RESWT, I BAE ST RGN AR Bon. BRI, Begtm “u” BT .

R T, Wid S Options > Block settings >Compile / Save>Executability R385 EkntE FC72,
weAEEE TR R M “Memory minimized” B84 b “Structure arrays” 3L OK BN » BHT 4 %¢ S7T-GRAPH

FB JfKs B hng 2] CPU .

7.2, 5ERBTIHER R

7.2.1. W AR R RERSRA RS G R

(e DA 75 S Rt e A S R 20 A5 R 2

i Mg i AE— D ER AT ST-GRAPH FB {75 St therb AR e — A48, AP iME Bl
SKAESL AT 2, AR (1 N A e T LUE 455 4 1007 SR AT Us ), M iR rp Bl XM= 51 4
D, HPAE RS SR .

o G7S[1].X HFE/RP BB

e G7S[1].SNO HFE /M) b5

Blin=s8 1 Bealnt, rTROEE I MRV R 25 1 RIE B
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Excellence in
Automation & Drives:
Siemens

SIEMENS

A FB2.G7S [1].X
= M0.0 //MO. 0 FEAE 1 HTE 1 AR RS
L FB2.G7S [1].SNO
T MW2 //MW2 A BTS2 )7
e 474 0ptions > Block settings > Compile/Save”™, % “Structure arrays” #ETi,

USRI, SRR 5 D M, DR RN G i A A

o HUEXAFRGTS

o TR CPMER) * 32

Block settings x|

Compile / Save | Messagesl Process Diagnusticsl

—FB Parameters — Interface D escription
™ Mirimum " Memary minimized (az of W6.1)
" Standard % Shucture arays I
" b awimum [az of ¥4.0] O Individual structures
&+ User-defined [V5.x] ¥ Download to PLC

B 7-4: & “Structure arrays” iEIN

7.2.2. A WIS REEER A IR R A RIE B

EF R R ERF IR NS e €/ R ibE S S LN PN
a5 AEW SEE RPN B S B AE D a2 b X A AR S AR
SR TV, CTT” H TSV KBS IRIES), X — e S A% S o st o2 i .

o TV: BR¥RSAEA (R
o TT: F¥rscfE NI (G84L: BOOL)
P'S

o TS: BeHAATFUIH(

#. BOOL)

. BOOL) »

N R 7 i) L &5 44 (ZE ST-GRAPH FB PA38) B M. STEP 7 B (LAD/STL/FBD i 5%) AT A3 1l 4% =X
T,
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Excellence in
Automation & Drives:
Siemens

SIEMENS

e T002.TT
VA U7 ) A A O A 8 A5 - A R IR 5 ) BT A4 R EEAT I
e G7T [2].1T

AR IR) AT 3 A 2 b B R R S A B T A IR TR

HEERIESH R QT (8 15 S 5 B o 020 2l B A

ol

7.2.3. W e B SR T ERHEEE_ LRITESD

8 7E T BB D) 2] A BS, i 7E B S i = RhseE LI iE sl ?
fiRAr s DS 3 RS A CRAEAE L A I 15 LB s, GBI 15 S e A B, PRSI L
K.
1 YT D AR T35 S BB B i s (ARRAY)  “SAX” ot Sy T (A7 4 B (2 (s
DAL BE B 28 T S B B A7 1% 5L vl LA F R ZE BBk SFC 20 “BLKMOV 7 K5
DAl riita
CALL "BLKMOV” //#E DB2 Az & fisic SAX field JF{fA7_SAX ARRAY[L..50]
SRCBLK :="MY_DB1”. SAX
RET_VAL :=MW66

DSTBLK :="MY DB2”.Save SAX

2. WREETFIEORAFIN A, T84 N 24 SR 2 v B A 18 250 (deactive)o SRS AEH]
RGLT)RE SFC 20 FEWIALRAT s S 2715 S Bl B “SONX” X 3
CALL "BLKMOV” //53 i bric 20 5%
SRCBLK: ="MY DB2”. Save SAX
RET_VAL:=MW66
DSTBLK: ="MY_DB1”. SONX
3. FEEBTEGE AT, ] “OFF_SQ” 155 kiF LRI SN A 20 . AECRAFTG S0 MIBE S (Y
PG 22 [R] PR BT T Py A 6 0 M B A ATART L5
TR ZWZE, ORI ol RS0 .

SBIEAE P R “SAX” R “SONX” R BE B gk T MU 4% (0 45 4 OFAT28) o AT T 0RAF “SAX” 3K
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Automation & Drives:
S"“‘”""’”*—) SIEMENS

HEV IR PN
RSN T P T 6% X (B S WAN E R EIS B BA S R RV B B2 IS Fi N BRI P N T E ki & S5 6 I (/N 6
e HE AL BSERT s sh b .

7.2.4. A G SEEL R RS I T SK BN A B T — B RIS

)R, e] SEERZE WA T4 (Supervision Disturbance) TWiSEERdE2S 2T — 5 15 H 2

fRR 25 WAL ST-GRAPH ) £ F v R 4 — A Wi ¥ F Hi (Supervision Disturbance), K
Supervision=TRUE. A %S T-HALIUEILHASH “ACK_EF” ik BN G MRS A4 2 gk
1BAT. T RMARE T AT A I 25 “ACK_EF” HEATHfIA 2K,

{E ST-GRAPH sZHH  “Options > Block Settings> Compile / Save>Sequencer Properties”,
ERH  “Acknowledge errors” Ilfig.

Block settings

Compile / Save I Messagesl Process Diagnnsticsl

— FB Parameterz — Interface Description
" Minimum " Memary minimized [az of 45.1]
f* Standard % Structure arays
™ Maximum [as of ¥4.0) i~ Individual structures
" User-defined [v5.x] v Download to FLC
— Esecutability — Sequencer Properties
" Full code [ Criteria analysiz data in DB
F. Stapdard FC required [~ Skip steps
WiithAwithout meszages FCYOAFCT
Uszer-defined: FC72 W Acknowledge emors
tinirnized: FC73 —
FC rumber: I—?2 [~ Synchronization [az of "».-’4.EI]
I™ | Eermanent processitg of &
_ irteroeke i manua aperation
 Warnings [ Lock operating mode selection [45.x]
" Mone
[ Sale activation mode [az of ¥5.1]
Lo |

[~ Use as defaults for new blocks

Cancel | Help |

K 7-5: 3 “Acknowledge errors” IhfiE

HE, MR LN “FB Parameters” JoFH TikIN “Minimum” FEANREILEFEZIGE. UL G256 h

“FB Parameters” JF] “Standard”, “Maximum” B “User—defined”
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Excellence in
Automation & Drives:
Siemens

SIEMENS

WERAER LA L7, A R ife] PR, el OB AR P2 4 Bkl Supervision {55 5CHL
AL (R D RE o

Interlock
C
M1.7_| i Supervision
Transf_ TT_o - Lt
-
52 Stepz
itepd I Al.Z2
M1 o_| < ¥ =
mi.z_| L e _;msi
53
7-6: FEJT@ il Supervision f55
FEFF 3B«

ML 7=1 i, JFH ML O FIML. 2 Wk« 17, ik, PRI BL R — B, mili#s T3 (Supervision

Disturbance) £ AL, RIMIFGHE B LET T, DIZER “Acknowledge errors” Ljfig.
7.2.5. [AJfR: WAHEE ST-GRAPH JIFidss 28 i) & 5

) R fu{AT A o ST-GRAPH MRS 2% () s 2 2

fift ;. ST-GRAPH 4% 2% (1) FB S 50/¢4ik 15249 DB v, 1M HL FB S ALt % R B T O e %
“Compile / Save” MJSZHL “Options > Block Settings” WK 'E . XH K E “FB Parameters”
o “User—defined (V5.x)”.

FEX) ST-GRAPH I 38 BEAT S BEFNRAE S, AT T B KIS HUEE P 768 (FB, FC or OBL) H
W ST-GRAPH FB. ILTE, ] LG T — LS HOk Al e Mg a5 PR S SO 8

i 25

e S NO: (T2 k=1
S MORE: HmJ7E S NO i s Z (hig 55

S ACTIVE: &8 ikl

SEF_DISP: M B sl b k)4 3&
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Automation & Drives:

ﬁ:eﬂence in
Si'emens‘)

SIEMENS

ERROR: T35 20 H 1) H B 1%

FAULT: AT= 0 s sn

it 24

DISP SEF: H G nifhst

T 205 D A& 2% ST-GRAPH T/l 5&F STEP Structure #=i.

7.2.6. [ RAT AR AR FAMBREREGR, RREFSVIBREIT 2

el A TR AL B4 S R AR A I, e S Ul B R — 282

fis

=

: fE ST-GRAPH 4+, XJME#84fF (Supervision) [FHd 1T

WM E&AF (Supervision) Wlifd, WM VI KB, WEESA TR T8, Uab
TREFEOE, SIS Si.U {5k,

W B4R 4 F (Supervision) AN, FFHMHTD W F— 0 A AL, s aas i
R 7

BEREEFERNRE: TN, EeE TSR, RERIREST IR E. KRfifE—
AT R S SR AR S RO, M2 Ul R EIRRID 2 mP R A R I

W7 RPREAT 20 e 4
Interlock
-
Supervision

Ml.2_ | Q - W
U: T#OO0Om=
T: T#4=2Z20ms
Bteps
N Mz2.2 [1]

M1.Z_
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Automation & Drives:
Siemens

SIEMENS

B 7-T: D R
T AR S S P, fln -

o ML.2 MM, JFH
o ML 3 HIFHHA I

7.2.7. BB AT ARELBFMRA T, ERITSHIRRSIE “LO S” #3iT?

L AT 2 RS HBA AR S, (BRI I REE “LO S kAT ?

ff%: AE ST-GRAPH 1, — Bl il DURYE LUK S5 5 I S gefih A . AEFAF “LO 87 (1%
OUN URFRA IR R B 1, R BN D 1 BB AR A5 IRES 0 el 1
I, SRR A . CHAACPERIR, B 25D,

ST-GRAPH [{—PEEAREN: B BRI — AP ARES DRAT T4 2. B, R — A TRiAAT
HBAAAE R I DN E Dy “ e i) CREBRBsRBIIA D, WD BT, “L0 87 J54 52
BT

7.2.8. F: ITHTES P FIN 5SRO0 4 53 SRR A LR A BT S 55

W) WA TE A% A RTINS 2 S8R 2 PF 0 SCIE AN T S0 S AN T 52 52 1) 20 2
s HICAERY &R “View > Sequencer”, DIERFIENINYEAS. s A AR SE bk

Pear S “Insert New Element > Alternative Branch > Open”. Xghnl LUFEAN—"N44E0 %
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Step + Transition  Ckrl+1
— Tt Tl Cut Chrl+s
L—  Copy el
Delete Dl B |Step6
Cbject Properties... Alk+Return 1
54 ‘Step% |
Jtep4d
T4
____________________________ —_—
[Transd
55 ‘StepS |
3teph
52 3tep:z
Jtepi
3tepd

K 7-8: NN X
TENIBIEE R 25 1123 ST A3 N HP 1 B 4 A F BT DI IS 25350 43, T HAT R 4 “Edit > Paste”s
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Excellence in
Automation & Drives:

Siemens s I E M E N s

EE 57 Graph - [FB51,DB51 (Sequencer, 1) -- Test_Projeki\S7-Programm(1)\...]

i+ File MEsi# Insert PLC Debug  Wiew Options Window Help

le o ] ] ] v oo ] [ sl o

E Copy Ctr+C = inkonmentar
| gl Delete Del
Renurmber. ..
| ] 5 s N
=l Find/Replace... Ctrl+F ﬁl_a' ﬁ JH: AL ’ }JF ,@E )EH
[ GoTo Paste fiy %, MIIEFE

(K13 Rk 2
353

T
I I 3
NI

“Cut »

7-9: Rl — AN EAT L

7.2.9. AE: WTAESE—> 0B1 A e B —KiE A ST-GRAPH FB 3% F i 5%
W) ARl eSS —> OB1 JE A 858 — i FH ST-GRAPH FB B 5 P i 4 2

fiftZs: iS40 OFF_SQ ZMH# il iys 45 FB 4 “INIT_SQ” 1 “OFF_SQ” W FH kA1 44k A5 P i
g%, TR ORI 28 G R0 LR AR R 1K

“Options > Block settings... > Compile/Save > FB Parameters FHIZ# “Standard” . “

Maximum” BY “User—defined” Z T HI—AN & ¥0E .

TEER T X ST-GRAPH FB [#i FH, YK, wFEMO. 0 U3 A% % “OFF _SQ” , X 4FET
TR, “OFF_SQ” SRR —A LI, FECHIIESS .
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OBl : "HMain Program 3weep [(Cycle]™
TS calling 57-GRAPH-FE
DESO
FESO

... —EN
—I |—|HEI.III —o|OFF_30 |

M0.1 —INIT 30

Mo, z —&CE_EF
. — 3 _PREV

. =3 _NEXT SN0, .,

7-10: G A
M3 Supervision ISR
TEER T LWIEHE) s M10. 3 B PRI T a4 k. R M10. 3 24 “False”, WHZh)E,
Jitdzs 3B AT 2 MNP HA S Y0, U7EH B S LI “Acknowledge errors” B, H&
75 FB 4 NS4 “ACK_EF” BEATHEIN)S, I 3 Bl 4k S0 AT

Interlock

Superwiszion

1T TH#OOOm=
T: TH#I=3450ms
Cmp Stepl
Stepl.T
Bt > N |mz.1
TH23 | || a1
M1.1 _ ] :
ML.7_

B 7-11:305d Supervision SR hidss 2
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SIEMENS

7.2.10. BRR: At AHEES B A —MEIRE R

W AT AT RS LR T RE P AR — AR 45 L2
fit2s: M ST-GRAPH H%{f & BCD 5 [k =X, 4 S N 110 Bt A 202 BCD At (4% 2 (3 A -3
# BCD) , FEI 4G N H)iETRME L CHO00 2] C#999.,

7.2.11. B AR R EE RIS S — A

W Ay AN s o JeVE I R P s o — AN b0

il XRA)FEH LRI — MR, ST-GRAPH Hf it T —28454, n] DAYENAAE 2 i F -
T A 28 PP R A0 o (AR BRI A s FERR T VR B 2D 2 T, 45 B0 ¢
VARITD R4, 15 MR 3 A S BAT LI D)4 .

7.2.12. [ AN ST-GRAPH i

e f: fnfe N85 S7T-GRAPH Bt ?
fift%: 76 STEPT th, A7 STL Y S A SCRF BRI DA, AUNAT ST-GRAPH Y S AF G105 LR
k. DUy LBt ST-GRAPH Y5 SR i STL A 20 S 1 7 s R A4 h ik
CIRYEC3iGR M S
1. H%cks ST-GRAPH FB #4724 ST-GRAPH FB 5 SC#F
o TJF ST-GRAPH FB, Jfiii “File > Generate Source File...” il ST-GRAPH Y5 3¢
.
o (EATIFHIRTRAE o A R4 FR, B4 “Source FB” .
o T OK H#HEATI#A7, AT ST-GRAPH J§SCfF)5, %] ST-GRAPH FB.
2. Ak STL #% =X f% FB
e {F Windows ¥fE & %h, Wit “Start > SIMATIC> STEP 7 > LAD, STL, FBD-Programming
S7 Blocks” #TJF LAD/STL/FBD %% #% .
o {E LAD/STL/FBD #iff#sh, il “File > Open” #$f STEP 7 3 H, #IJF/E S7T-GRAPH
I ER (B4 FB51) o
o IEFERET “File > Save”, MM RIR(EEIRR: HWHURAEAFE i E 5 QI m,
TRAE 5 WIS B T 546 Q5 5 (ST-GRAPH) HEAT 4t . il “Yes” $9edHl. WITE
ST-GRAPH TR (M ThRed, BIEC 4N STLIESHAT .
3. AR STL A% S AT
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o fE LAD/STL/FBD 4mff#% il “File > Generate Source...” B STL JH3C
o TEFTIFHINTERE A A R4 FR, Bl “Protect FB” .
o EFPEUNILAIE STL FICHERIER (B4 FB51) , FEHXANREE B4 141 “Blocks
Selected” M,
o LLOKAfiA, Azl STL Y3, SGH] LAD/STL/FBD S’ o
4. PUEAE “Sources” SCIEIEH A BANE S
o  STL LA (Protect FB),
o  ST-GRAPH J§ 3} (Source FB),
5. AR FB
o FIJFSTL YA “Protect FB”, JFAE “TITLE” "I IRHRIR 7 Bedei A KB 5
KNOW_HOW_PROTECT

e ilijt “File > Save” and “File > Compile” fRAFI4mi% STL Y5 4. W FB51 #%hn%% .
8. Pz —IEFEMHE
8.1. AI'TF B3 5 WIN = M FIFE L BRI R

T CRED A7BRA A HEb L SRR % s 5 Sk

WG T . http://www.ad.siemens.com.cn/Service/

LR HELERS HSCRY:  http://www.ad.siemens.com.cn/Service/recommend.asp

ASH ] a] 55 :  http://support.automation.siemens.com/CN/view/zh/10805055/133000

ASHH{Z & http://support.automation.siemens.com/CN/view/zh/10805055/133400

“HeBZ” ASHRIX : http://www.ad.siemens.com.cn/service/answer/category.asp?cid=1027
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